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How Do I?

Learn how to use your HP Deskjet 2520 series

. Printer parts

. Copy documents or photos
. Load media

. Replace the cartridges
Clear a paper jam

How Do I?
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2 Get to know the HP Deskjet 2520 series

. Printer parts
. Control panel features

. Status lights

Printer parts

Output tray extender (also referred to as the tray extender)
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1 | Input tray z O
2 | Input t d o
nput tray guar £ §
3 | Paper-width guide for the input tray go
4 | Control panel 8 %
5 | Cartridge door
6 | Output tray
7
8

Cartridges
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Chapter 2

Control panel features

1 | Power: Turns the product on or off. When the product is off, a minimal amount of power is still used. To completely
remove power, turn off the product, then unplug the power cord. See Status lights for more information.

Scan: Initiates a front panel scan job after connection to computer has been established.
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Cancel: Stops the current operation.

Fit to page: Enlarges or reduces the original placed on the glass.

Fit to page light: Indicates whether the enlarge or reduce function has been selected.

Start Copy Black: Starts a black-and-white copy job. Increase the number of copies by pressing the button multiple
times. Acts as a resume button after resolving print problems.

7 | Start Copy Color: Starts a color copy job. Increase the number of copies by pressing the button multiple times. Acts as a
resume button after resolving print problems.

Attention light: Indicates that there is a paper jam, the printer is out of paper, or some event that requires your attention.

|| W|DN

Control panel display: Indicates the number of copies, media error, ink level, and ink error.

Auto Power-Off is automatically enabled by default when you turn on the printer. When Auto Power-Off is
enabled, the printer will automatically turn off after two hours of inactivity to help reduce energy use. See Auto

Power-Off for more information.

Status lights

When the product is turned on, the power button light will be lit. When the product is processing a job, the power
light will be blinking. Additional blinking lights signal errors that you can resolve. See below to learn about blinking

lights and what to do.

Behavior Cause and solution

Power light is blinking and attention light is on. Output tray closed when printing is attempted.
Open output tray.

6 Get to know the HP Deskjet 2520 series



(continued)

Behavior

Cause and solution
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Power light, ink levels, and attention light are blinking.
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Ink access door is open.
See Prepare the trays.

Both ink level icons are blinking.

Both cartridges are missing, or do not have the
tape removed, or may be defective.

Install cartridges, or remove the pink tape from

the cartridges, or replace the defective cartridges.

See Replace the cartridges for more information.
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Blinking icon indicates corresponding cartridge is
missing, or does not have the tape removed, or
may be defective. The printer will print in single-
cartridge mode with one cartridge.

Install missing black or color cartridge, or remove
the pink tape from the cartridge, or replace the
defective cartridge.
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There is no paper, or paper is not feeding.

Load paper, then press any button, except
Cancel, to resume printing. See Load media.
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There is a paper jam.

See Clear a paper jam. Load paper, then press
any button, except Cancel, to resume printing.

Letter "C", ink level icons, and attention light are blinking.
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Cartridge carriage inside printer has stalled.

Open cartridge door and make sure carriage is
not obstructed. Move carriage to the right, close
door, and then press any button, except Cancel,
to resume.

Power light, media icon, and attention light are blinking.
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Scanner is not working. Press Power button to
turn printer off, and then on again.

If problem persists, contact HP. Printer will still
print even if scanner is not working.

Status lights
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Chapter 2
(continued)

8

Behavior

Cause and solution

Power light, letter "E", media icon, ink level icons, ink drop icon, and
attention light are blinking.
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Printer is in an error state.
Reset printer.

1. Turn printer off.

2, Unplug power cord.

3. Wait a minute, plug power cord back in.
4. Turn on printer.

If problem persists, contact HP.

One ink level icon and ink drop icon are blinking, and the attention light is

on.
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Blinking ink level icon indicates that
corresponding cartridge has a problem. Cartridge
may be improperly installed, incompatible,
counterfeit or very low on ink.

. If you see a message on your computer

screen, refer to the message for more
information about the problem.

. If there is no message on your computer
screen, try removing and reinserting the
cartridge.

. Confirm that you are using the correct HP
cartridge for your printer.

. Determine if the cartridge is defective. See
Identify a defective cartridge.

. If print quality is poor, consider replacing

the cartridge. See Replace the cartridges.

Both ink level icons and ink drop icon are blinking, and the attention light

is on.
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Both cartridges have a problem. Cartridges may
be improperly installed, incompatible, defective,
counterfeit or very low on ink.

. If you see a message on your computer
screen, refer to the message for more
information about the problem.

. If there is no message on your computer
screen, try removing and reinserting the
cartridges.

. Confirm that you are using the correct HP
cartridges for your printer.

. Determine if a cartridge is defective. See
Identify a defective cartridge.

. If print quality is poor, consider replacing

the cartridges. See Replace the cartridges.
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3 Print

Choose a print job to continue.

% Print documents

‘ I Print photos

E Print envelopes

Print documents

To print from a software application

1.
2,

P

Make sure the output tray is open.
Make sure you have paper loaded in the input tray.

See Load media for more information.

From your software application, click the Print button.
Make sure the product is the selected printer.

Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties, Options, Printer Setup,
Printer, or Preferences.

Select the appropriate options.
. On Layout tab select Portrait or Landscape orientation.

. On Paper/Quality tab select the appropriate paper type and print quality from the Media drop-down
list.

. Click Advanced to select the appropriate paper size from the Paper/Output list.
Click OK to close the Properties dialog box.
Click Print or OK to begin printing.

Print




Chapter 3

Br NOTE: You can print your document on both sides of the paper, instead of just one side. Click on the
Advanced button on the Paper/Quality or Layout tab. From the Pages to Print drop-down menu select
Print Even Pages Only. Click OK to print. After the even numbered pages of the document have been
printed, remove the document from the output tray. Reload the paper in the input tray with the blank side up,
and top of page down. Return to the Pages to Print drop-down menu and then select Print Odd Pages
Only. Click OK to print.

Print photos

To print a photo on photo paper
1.  Make sure the output tray is open.
2.  Remove all paper from the input tray, and then load the photo paper print side up.

Bf NOTE: If the photo paper you are using has perforated tabs, load photo paper so that tabs are on top.

See Load media for more information.
3. On the File menu in your software application, click Print.
Make sure the product is the selected printer.
5.  Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties, Options, Printer Setup,
Printer, or Preferences.

6. Click the Paper/Quality tab.
7.  Select the appropriate options.
. On Layout tab select Portrait or Landscape orientation.

. On Paper/Quality tab select the appropriate paper type and print quality from the Media drop-down
list.

. Click Advanced to select the appropriate paper size from the Paper/Output list.

P

Bf NOTE: For maximum dpi resolution, go to the Paper/Quality tab and select Photo Paper, Best
Quality from the Media drop-down list. Make sure you are printing in color. Then click the Advanced
button and select Yes from the Print in Max DPI drop-down list. For more information, see Print using

the maximum dpi.

8. Click OK to return to the Properties dialog box.
9. Click OK, and then click Print or OK in the Print dialog box.

Br NOTE: Do not leave unused photo paper in the input tray. The paper might start to curl, which could reduce
the quality of your printout. Photo paper should be flat before printing.

Print envelopes

You can load one or more envelopes into the input tray of the HP Deskjet 2520 series. Do not use shiny or
embossed envelopes or envelopes that have clasps or windows.

10 Print



Br NOTE: For specific details on how to format text for printing on envelopes, consult the help files in your word
processing software. For best results, consider using a label for the return address on envelopes.

To print envelopes
1. Make sure the output tray is open.
2.  Slide the paper guide all the way to the left.

3.  Place the envelopes in the right side of the tray. The side to be printed on should face up. The flap should
be on the left side.

4. Push the envelopes into the printer until they stop.
5.  Slide the paper guide firmly against the edge of the envelopes.

See Load media for more information.
6.  Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties, Options, Printer Setup,
Printer, or Preferences.

7.  Select the appropriate options.
. On Paper/Quality tab select the appropriate type from the Media drop-down menu.

. Click the Advanced button, and select the appropriate envelope size from the Paper Size drop-down
menu.

8. Click OK, and then click Print or OK in the Print dialog box.

Tips for print success

To successfully print, the HP cartridges should be functioning properly with sufficient ink, the paper should be
loaded correctly, and the product should have the appropriate settings.

Cartridge tips
. Use genuine HP ink cartridges.
. Install both the black and tri-color cartridges correctly.

For more information, see Replace the cartridges.
. Check the estimated ink levels in the cartridges to make sure there is sufficient ink.
For more information, see Check the estimated ink levels.

. For more information, see Improve print quality.

Paper loading tips

. Load a stack of paper (not just one page). All of the paper in the stack should be the same size and type to
avoid causing a paper jam.

. Load paper with the side to be printed on facing up.

. Ensure that paper loaded in the input tray lies flat and the edges are not bent or torn.

. Adjust the paper-width guide in the input tray to fit snugly against all paper. Make sure the paper-width
guide does not bend the paper in the input tray.

. For more information, see Load media.

Tips for print success 11
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Printer settings tips

On the Paper/Quality tab of the print driver, select the appropriate paper type and quality from the Media
drop down menu.

Click the Advanced button, and select the appropriate paper size from the Paper Size drop-down menu.
Click the HP Deskjet 2520 series desktop icon to open the Printer Software.

Bf NOTE: You can also access the Printer Software by clicking Start > Programs > HP > HP Deskjet
2520 series > HP Deskjet 2520 series

Notes

Genuine HP ink cartridges are designed and tested with HP printers and papers to help you easily produce
great results, time after time.

Br NOTE: HP cannot guarantee the quality or reliability of non-HP supplies. Product service or repairs
required as a result of using a non-HP supply will not be covered under warranty.

If you believe you purchased genuine HP ink cartridges, go to:

www.hp.com/go/anticounterfeit

Ink level warnings and indicators provide estimates for planning purposes only.

Bf NOTE: When you receive a low-ink warning message, consider having a replacement cartridge
available to avoid possible printing delays. You do not need to replace the cartridges until print quality
becomes unacceptable.

Software settings selected in the print driver only apply to printing, they do not apply to copying or scanning.
You can print your document on both sides of the paper, instead of just one side.

Bf NOTE: Click the Advanced button on the Paper/Quality or Layout tab. From the Pages to Print
drop-down menu select Print Odd Pages Only. Click OK to print. After the odd numbered pages of the
document have been printed, remove the document from the output tray. Reload the paper in the input
tray with the blank side facing up. Return to the Pages to Print drop-down menu and then select Print
Even Pages Only. Click OK to print.

Print using black ink only

BY NOTE: If you want to print a black and white document using black ink only, click the Advanced
button. From the Print in Grayscale drop-down menu select Black Ink Only, then click the OK button.
If you see Black and White as an option on the Paper/Quality tab or the Layout tab, select it.

Print using the maximum dpi

Use maximum dots per inch (dpi) mode to print high-quality, sharp images on photo paper.

See technical specifications for the print resolution of the maximum dpi mode.

Printing in maximum dpi takes longer than printing with other settings and requires a large amount of disk space.

To print in Maximum dpi mode

1.

2.
3.
4

12 Print

Make sure you have photo paper loaded in the input tray.
On the File menu in your software application, click Print.
Make sure the product is the selected printer.

Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties, Options, Printer Setup,
Printer, or Preferences.

Click the Paper/Quality tab.


http://www.hp.com/go/anticounterfeit

10.
1.

In the Media drop-down list, click Photo Paper, Best Quality.

Ef NOTE: Photo Paper, Best Quality must be selected from the Media drop-down list on the Paper/
Quality tab to enable printing in maximum DPI.

Click the Advanced button.

In the Printer Features area, select Yes from the Print in Max DPI drop-down list.
Select Paper Size from Paper/Output drop-down menu.

Click OK to close the advanced options.

Confirm Orientation on Layout tab, then click OK to print.

Print using the maximum dpi

13
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4 Paper basics

You can load many different types and sizes of paper in the HP Deskjet 2520 series, including letter or A4 paper,
photo paper, transparencies, and envelopes.

This section contains the following topics:

. Recommended papers for printing
. Load media

Recommended papers for printing

If you want the best print quality, HP recommends using HP papers that are specifically designed for the type of
project you are printing.

Depending on your country/region, some of these papers might not be available.

ColorLok

. HP recommends plain papers with the ColorLok logo for printing and copying of everyday documents. All
papers with the ColorLok logo are independently tested to meet high standards of reliability and print
quality, and produce documents with crisp, vivid color, bolder blacks, and dry faster than ordinary plain
papers. Look for papers with the ColorLok logo in a variety of weights and sizes from major paper
manufacturers.

HP Advanced Photo Paper

. This thick photo paper features an instant-dry finish for easy handling without smudging. It resists water,
smears, fingerprints, and humidity. Your prints have a look and feel comparable to a store-processed photo.
It is available in several sizes, including A4, 8.5 x 11 inch, 10 x 15 cm (4 x 6 inch) (with or without tabs), 13 x
18 cm (5 x 7 inch), and two finishes - glossy or soft gloss (satin matte). It is acid-free for longer lasting
documents.

HP Everyday Photo Paper

. Print colorful, everyday snapshots at a low cost, using paper designed for casual photo printing. This
affordable, photo paper dries quickly for easy handling. Get sharp, crisp images when you use this paper
with any inkjet printer. It is available in semi-gloss finish in several sizes, including A4, 8.5 x 11 inch, and 10
x 15 cm (4 x 6 inch) (with or without tabs). For longer-lasting photos, it is acid-free.

Paper basics

HP Brochure Paper or HP Superior Inkjet Paper

. These papers are glossy-coated or matte-coated on both sides for two-sided use. They are the perfect
choice for near-photographic reproductions and business graphics for report covers, special presentations,
brochures, mailers, and calendars.

HP Premium Presentation Paper or HP Professional Paper

. These papers are heavy two-sided matte papers perfect for presentation, proposals, reports, and
newsletters. They are heavyweight for an impressive look and feel.

Paper basics 15
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Chapter 4

HP Bright White Inkjet Paper

. HP Bright White Inkjet Paper delivers high-contrast colors and sharp text. It is opaque enough for two-sided
color usage with no show-through, which makes it ideal for newsletters, reports, and flyers. It features
ColorLok Technology for less smearing, bolder blacks, and vivid colors.

HP Printing Paper

. HP Printing Paper is a high-quality multifunction paper. It produces documents that look and feel more
substantial than documents printed on standard multipurpose or copy paper. It features ColorLok
Technology for less smearing, bolder blacks, and vivid colors. It is acid-free for longer lasting documents.

HP Office Paper

. HP Office Paper is a high-quality multifunction paper. It is suitable for copies, drafts, memos, and other
everyday documents. It features ColorLok Technology for less smearing, bolder blacks, and vivid colors. It
is acid-free for longer lasting documents.

HP Iron-On Transfers

. HP Iron-on Transfers (for color fabrics or for light or white fabrics) are the ideal solution for creating custom
T-shirts from your digital photos.

HP Premium Inkjet Transparency Film

. HP Premium Inkjet Transparency Film make your color presentations vivid and even more impressive. This
film is easy to use and handle and dries quickly without smudging.

HP Photo Value Pack

. HP Photo Value Packs conveniently package original HP cartridges and HP Advanced Photo Paper to save
you time and take the guesswork out of printing affordable professional photos with your
HP Deskjet 2520 series. Original HP inks and HP Advanced Photo Paper have been designed to work
together so your photos are long lasting and vivid, print after print. Great for printing out an entire vacation’s
worth of photos or multiple prints to share.

Br NOTE: At this time, some portions of the HP Web site are available in English only.

To order HP papers and other supplies, go to www.hp.com/buy/supplies. If prompted, choose your country/
region, follow the prompts to select your product, and then click one of the shopping links on the page.

Load media

A Select a paper size to continue.

Load full-size paper
a. Raise the input tray
O Raise the input tray.

b. Lower the output tray
O  Lower the output tray and pull out the tray extender.

16 Paper basics
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c. Slide paper-width guide to the left
Q  Slide paper-width guide to the left.

d. Load paper.
O  Insert stack of paper into input tray with short edge forward and print side up.

O Slide stack of paper down until it stops.
Q  Slide paper-width guide to the right until it stops at edge of paper.

Paper basics

Load small-size paper
a. Raise the input tray
O  Raise the input tray.

Load media 17
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b. Lower the output tray
Q  Lower the output tray and pull out the tray extender.

c. Slide paper-width guide to the left.
Q  Slide paper-width guide to the left.

d. Load paper.
O  Insert stack of photo paper with short edge down and print side up.

O Slide stack of paper forward until it stops.

Br NOTE: If the photo paper you are using has perforated tabs, load photo paper so that tabs
are on top.
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Q  Slide paper-width guide to the right until it stops at edge of paper.

18 Paper basics



Load envelopes
a. Raise the input tray
Q  Raise the input tray.

b. Lower the output tray
Q  Lower the output tray and pull out the tray extender.

c. Slide paper-width guide to the left.
Q  Slide paper-width guide to the left.

Paper basics

U Remove all paper from the main input tray.
d. Load envelopes.

Q Insert one or more envelopes into far-right side of the input tray. The side to be printed on should
face up. The flap should be on the left side and facing down.

O Slide stack of envelopes down until it stops.
Q  Slide paper-width guide to the right against stack of envelopes until it stops.

Load media 19
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5 Copy and scan

. Copy documents or photos
. Scan to a computer

. Tips for copy success

. Tips for scan success

Copy and scan

Copy documents or photos

Br NOTE: All documents are copied in normal quality print mode. You cannot change the print mode quality
when copying.

A Do one of the following:

1-sided original to 1-sided copy
a. Load paper.
QO  Load either small photo paper or full-size paper in the input tray.

b. Load original.
Q  Liftlid on product.

Q  Load original print side down on right front corner of glass.

Copy and scan 21
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O  Close lid.

c.  Start copy.
O Press Fit to Page to enlarge or reduce the original.
Q  Press either Start Copy Black or Start Copy Color. Increase the number of copies by pressing

the button multiple times.

Scan to a computer

Br NOTE: To scan to a computer, the HP Deskjet 2520 series and computer must be connected and turned on.

A To scan to a computer:

Single page scan
a. Load original.
Q  Liftlid on product.

Q  Load original print side down on right front corner of glass.

22 Copy and scan



Copy and scan

4 Close lid.

b. Startscan.

O  Start the scan job by either pressing Scan on the control panel or using the Printer Software.
Click the HP Deskjet 2520 series desktop icon to open the Printer Software.

Br NOTE: You can also access the Printer Software by clicking Start > Programs > HP > HP
Deskjet 2520 series > HP Deskjet 2520 series

Q  Select Scan a Document or Photo. You will see scan options that you can select onscreen.

Tips for copy success

. Load your original print side down on the right front corner of the glass.

Tips for copy success 23
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Press Fit to Page to enlarge or reduce the original image to fit the paper size on which you are printing.
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. Click here to go online for more information.

Tips for scan success

. Load your original print side down on the right front corner of the glass.
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Clean the scanner glass and make sure that there are no foreign materials adhering to it.

. Click here to go online for more information.

24 Copy and scan
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6 Work with cartridges

. Check the estimated ink levels
. Order ink supplies

. Replace the cartridges

. Use single-cartridge mode

. Cartridge warranty information

Check the estimated ink levels

You can easily check the ink supply level to determine how soon you might need to replace a cartridge. The ink
supply level shows an estimate of the amount of ink remaining in the cartridges.

The printer's control panel display shows the estimated ink level directly. Refer to the below instructions for
checking the detailed information about estimated ink level.
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To check the ink levels from the Printer Software
1. Click the HP Deskjet 2520 series desktop icon to open the Printer Software.

Bf NOTE: You can also access the Printer Software by clicking Start > Programs > HP > HP Deskjet
2520 series > HP Deskjet 2520 series

2. Inthe Printer Software, click Estimated Ink Levels.

Bf NOTE: 1 If you have installed a refilled or remanufactured cartridge, or a cartridge that has been used in
another printer, the ink level indicator might be inaccurate or unavailable.

NOTE: 2 Ink level warnings and indicators provide estimates for planning purposes only. When you receive
a low-ink warning message, consider having a replacement cartridge available to avoid possible printing
delays. You do not have to replace the cartridges until the print quality is unacceptable.

NOTE: 3 Ink from the cartridges is used in the printing process in a number of different ways, including in the
initialization process, which prepares the product and cartridges for printing, and in printhead servicing, which
keeps print nozzles clear and ink flowing smoothly. In addition, some residual ink is left in the cartridge after it
is used. For more information, see www.hp.com/go/inkusage.

Order ink supplies

Before ordering cartridges, locate the correct cartridge number.

Locate the cartridge number on the printer
A The cartridge number is located inside the cartridge door.
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Chapter 6

Locate the cartridge number in the Printer Software
1. Click the HP Deskjet 2520 series desktop icon to open the Printer Software.

Br NOTE: You can also access the Printer Software by clicking Start > Programs > HP > HP Deskjet
2520 series > HP Deskjet 2520 series

2. Inthe Printer Software, click Shop and then click Shop For Supplies Online. The correct cartridge number
will be automatically displayed when you use this link.

To order genuine HP supplies for the HP Deskjet 2520 series, go to www.hp.com/buy/supplies. If prompted,
choose your country/region, follow the prompts to select your product, and then click one of the shopping links on
the page.

Br NOTE: Ordering cartridges online is not supported in all countries/regions. If it is not available in your
country/region, you may still view supplies information and print a list for reference when shopping at a local
HP reseller.

Related topics
. Choose the right cartridges

Choose the right cartridges

HP recommends that you use original HP cartridges. Original HP cartridges are designed and tested with HP
printers to help you easily produce great results, time after time.

Related topics
. Order ink supplies

Replace the cartridges

To replace the cartridges
1. Check power.
2. Load paper.
3.  Remove cartridge.
a. Open cartridge door.

Wait for print carriage to move to center of the product.
b. Press down to release cartridge, then remove it from slot.
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4. Insert new cartridge.
a. Remove cartridge from packaging.

b. Remove plastic tape using pink pull tab.

c. Slide cartridge into slot until it clicks into place.

d. Close cartridge door.

5.  Align cartridges.

Replace the cartridges
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Use single-cartridge mode

Use the single-cartridge mode to operate the HP Deskjet 2520 series with only one print cartridge. The single-
cartridge mode is initiated when a print cartridge is removed from the print cartridge carriage. During single-
cartridge mode, the product can copy documents, copy photos, and print jobs from the computer.

Br NOTE: When the HP Deskjet 2520 series operates in single-cartridge mode, a message is displayed on
screen. If the message is displayed and two print cartridges are installed in the product, verify that the
protective piece of plastic tape has been removed from each print cartridge. When plastic tape covers the
print cartridge contacts, the product cannot detect that the print cartridge is installed.

Exit single-cartridge mode

Install two print cartridges in the HP Deskjet 2520 series to exit single-cartridge mode.

Related topics
. Replace the cartridges
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Cartridge warranty information

The HP cartridge warranty is applicable when the product is used in its designated HP printing device. This
warranty does not cover HP ink products that have been refilled, remanufactured, refurbished, misused, or
tampered with.

During the warranty period the product is covered as long as the HP ink is not depleted and the end of warranty
date has not been reached. The end of warranty date, in YYYY/MM format, may be found on the product as
indicated:

For a copy of the HP Limited Warranty Statement for the printer, see the printed documentation that came with
the product.
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7 Connectivity

. USB Connection (non-network connection)
. Connect a new printer

USB Connection (non-network connection)

The HP Deskjet 2520 series supports a rear USB 2.0 High Speed port for connection to a computer.

To connect the product with the USB cable

A Refer to the setup instructions that came with your product for information on connecting to a computer with
a USB cable.

Bf NOTE: Do not connect the USB cable to the product until you are prompted to do so.

If the printer software has been installed, the printer will operate as a plug and play device. If the software has not
been installed, insert the CD that came with the device and follow the onscreen instructions.

Connect a new printer

If you have already installed the printer software on your computer, but have not yet connected your printer, do
the following:

Connect a new printer

1. From the computer’s start menu select All Programs or Programs, and then select HP.
2.  Select HP Deskjet 2520 series.

3.  Select Printer Setup & Software.

4 Select Connect a new printer. Follow the onscreen instructions.
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8 Solve a problem

This section contains the following topics:

. Improve print quality

. Clear a paper jam
. Unable to print
. HP support

Improve print quality

1. Make sure you are using genuine HP cartridges.

2. Check the Printer Software settings to make sure you have selected the appropriate paper type and print
quality from the Media drop-down list.

3. Check the estimated ink levels to determine if the cartridges are low on ink. For more information, see
Check the estimated ink levels. If the print cartridges are low on ink consider replacing them.

4.  Align the printer cartridges.

To align the cartridges from the Printer Software

Br NOTE: Aligning the cartridges ensures high-quality output. The HP All-in-One prompts you to align the

=

@ 0o o0

cartridges every time you install a new cartridge. If you remove and reinstall the same print cartridge, the
HP All-in-One will not prompt you to align the print cartridges. The HP All-in-One remembers the
alignment values for that print cartridge, so you do not need to realign the print cartridges.

Load letter or A4 unused plain white paper into the input tray.

In the Printer Software, click Print & Scan and then click Maintain Your Printer to access the HP
Deskjet 2520 series Toolbox.

The HP Deskjet 2520 series Toolbox appears.

Click the Device Services tab.

Click Align Ink Cartridges tab. The product prints an alignment sheet.

Load the cartridge alignment sheet print side down on the right front corner of the glass.

Press the Start Copy Black button. The product aligns the cartridges. Recycle or discard the cartridge
alignment sheet.

5.  Print a diagnostics page if the cartridges are not low on ink.

To print a diagnostics page

a.
b.

Load letter or A4 unused plain white paper into the input tray.

In the Printer Software, click Print & Scan and then click Maintain Your Printer to access the HP
Deskjet 2520 series Toolbox.

Click the Device Reports tab.

Click Print Diagnostic Information to print a diagnostics page. Review the blue, magenta, yellow,
and black boxes on the diagnostics page. If you are seeing streaks in the color and black boxes, or no
ink in portions of the boxes, then automatically clean the cartridges
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6. Clean the print cartridges automatically, if the diagnostic page shows steaks or missing portions of the color
and black boxes.

To clean the cartridges automatically

a.
b.

c.
d.

Load letter or A4 unused plain white paper into the input tray.

In the Printer Software, click Print & Scan and then click Maintain Your Printer to access the HP
Deskjet 2520 series Toolbox.

Click the Device Services tab.

Click Clean Ink Cartridges. Follow the onscreen instructions.

If the above solutions do not resolve the problem, click here for more online troubleshooting.

Clear a paper jam

Clear a paper jam.

32

To clear a paper jam
1. Locate the paper jam

Input tray

If the paper jam is located near the back input tray, pull the paper gently out of the input tray.

Iz
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Output tray
. If the paper jam is located near the front output tray, pull the paper gently out of the output tray.

&

. You may need to open the carriage door and slide the print carriage to the right to access the paper
jam.

&

Inside of printer
. If the paper jam is located inside the printer, open the cleanout door located on the bottom of the
printer. Press tabs on both sides of the cleanout door.

&

. Remove jammed paper.

Solve a problem

2.  Press the Start Copy Black or Start Copy Color button on the control panel to continue the current job.
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If the above solutions do not resolve the problem, click here for more online troubleshooting.

Prevent paper jams

. Do not overfill the input tray.

. Remove printed papers from the output tray frequently.

. Ensure that paper loaded in the input tray lays flat and the edges are not bent or torn.

. Do not combine different paper types and paper sizes in the input tray; the entire stack of paper in the input
tray must be the same size and type.

. Adjust the paper-width guide in the input tray to fit snugly against all paper. Make sure the paper-width
guide does not bend the paper in the input tray.

. Do not force paper too far forward in the input tray.

If the above solutions do not resolve the problem, click here for more online troubleshooting.

Unable to print

If you're having trouble printing, you can download the HP Printing Diagnostic Utility, which can troubleshoot this
issue for you automatically. To get the utility, click the appropriate link:

Br NOTE: The HP Printing Diagnostic Utility may not be available in all languages.

Take me to the HP Printing Diagnostic Utility download page.

Resolve print issues

Br NOTE: Make sure that the printer is turned on and that there is paper in the tray. If you are still unable to
print, try the following in order:

1. Check for error messages and resolve.
2.  Disconnect and reconnect the USB cable.
3. Verify that the product is not paused or offline.

To verify that the product is not paused or offline

a. Depending upon your operating system, do one of the following:
. Windows 7: From the Windows Start menu, click Devices and Printers.
. Windows Vista: From the Windows Start menu, click Control Panel, and then click Printers.
. Windows XP: From the Windows Start menu, click Control Panel, and then click Printers and

Faxes.

b.  Either double-click the icon for your product or right-click the icon for your product and select See
what’s printing to open the print queue.

c.  On the Printer menu, make sure there are no check marks next to Pause Printing or Use Printer
Offline.

d. If you made any changes, try to print again.

4.  Verify that the product is set as the default printer.
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To verify that the product is set as the default printer

a. Depending upon your operating system, do one of the following:
. Windows 7: From the Windows Start menu, click Devices and Printers.
. Windows Vista: From the Windows Start menu, click Control Panel, and then click Printers.
. Windows XP: From the Windows Start menu, click Control Panel, and then click Printers and

Faxes.

b. Make sure the correct product is set as the default printer.
The default printer has a check mark in a black or green circle next to it.

c. Ifthe wrong product is set as the default printer, right-click the correct product and select Set as
Default Printer.

d.  Try using your product again.
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5.  Restart the print spooler.

To restart the print spooler

a.

C.

d.
6. Restart the computer.
7.  Clear the print queue.

Depending upon your operating system, do one of the following:

Windows 7

. From the Windows Start menu, click Control Panel, System and Security, and then
Administrative Tools.

. Double-click Services.

. Right-click the Print Spooler, and then click Properties.

. On the General tab, next to Startup type, make sure that Automatic is selected.

. If the service is not already running, under Service status, click Start, and then click OK.

Windows Vista

. From the Windows Start menu, click Control Panel, System and Maintenance,
Administrative Tools.

. Double-click Services.

. Right-click the Print Spooler service, and then click Properties.

. On the General tab, next to Startup type, make sure that Automatic is selected.

. If the service is not already running, under Service status, click Start, and then click OK.

Windows XP

. From the Windows Start menu, right click My Computer.

. Click Manage, and then click Services and Applications.

. Double-click Services, and then select Print Spooler.

. Right-click Print Spooler, and click Restart to restart the service.

Make sure the correct product is set as the default printer.
The default printer has a check mark in a black or green circle next to it.

If the wrong product is set as the default printer, right-click the correct product and select Set as
Default Printer.

Try using your product again.

Solve a problem

To clear the print queue

a.

Depending upon your operating system, do one of the following:

. Windows 7: From the Windows Start menu, click Devices and Printers.

. Windows Vista: From the Windows Start menu, click Control Panel, and then click Printers.

. Windows XP: From the Windows Start menu, click Control Panel, and then click Printers and
Faxes.

Double-click the icon for your product to open the print queue.

On the Printer menu, click Cancel all documents or Purge Print Document, and then click Yes to

confirm.

If there are still documents in the queue, restart the computer and try printing again after the computer

has restarted.

Check the print queue again to make sure it is clear, and then try to print again.

If the print queue is not clear, or if it is clear but jobs are still failing to print, proceed to the next

solution.

If the above solutions do not resolve the problem, click here for more online troubleshooting.
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Clear the print carriage

Remove any objects, such as paper, that are blocking the print carriage.

Br NOTE: Do not use any tools or other devices to remove jammed paper. Always use caution when removing
jammed paper from inside the product.

. Click here to go online for more information.

Identify a defective cartridge

If both the tri-color and black ink level indicators are blinking, and the power light is on, both cartridges may still
have tape on, or are missing. First make sure that the pink tape has been removed from both cartridges, and that
both cartridges are installed. If both ink level indicators are still blinking, then one or both cartridges may be
defective. To determine if one cartridge is defective do the following:

1. Remove black cartridge.

2.  Close cartridge door.

3. If the Power light blinks, the tri-color cartridge should be replaced. If the On light does not blink, replace the
black cartridge.

Prepare the trays

Open output tray
A Output tray must be open to begin printing.

Close cartridge door
A Cartridge door must be closed to begin printing.

. Click here to go online for more information.
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Resolve copy and scan issues

a" Click here to go online for more information.

HP support

Register the product
. Support process
. HP support by phone
. Additional warranty options

Register the product

By taking just a few quick minutes to register, you can enjoy quicker service, more efficient support, and product
support alerts. If you did not register your printer while installing the software, you can register now at http://
www.register.hp.com.

Support process

If you have a problem, follow these steps:

1. Check the documentation that came with the product.

2. Visit the HP online support Web site at www.hp.com/support. HP online support is available to all HP
customers. It is the fastest source for up-to-date product information and expert assistance and includes the
following features:

. Fast access to qualified online support specialists

. Software and driver updates for the product

. Valuable product and troubleshooting information for common problems

. Proactive product updates, support alerts, and HP newsgrams that are available when you register the
product

3. Call HP support. Support options and availability vary by product, country/region, and language.

Solve a problem

HP support by phone
Phone support options and availability vary by product, country/region, and language.
This section contains the following topics:

. Phone support period

. Placing a call

. Support phone numbers

. After the phone support period

Phone support period

One year of phone support is available in North America, Asia Pacific, and Latin America (including Mexico). To
determine the duration of phone support in Europe, the Middle East, and Africa, go to www.hp.com/support.
Standard phone company charges apply.

Placing a call

Call HP support while you are in front of the computer and the product. Be prepared to provide the following
information:

. Product name (located on product, such as HP Deskjet 2520 series)
. Product number (located inside the cartridge access door)
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. Serial number (located on the back or bottom of the product)
. Messages that appear when the situation occurs
. Answers to these questions:
° Has this situation happened before?
° Can you re-create it?
° Did you add any new hardware or software to your computer at about the time that this situation
began?
° Did anything else occur prior to this situation (such as a thunderstorm, product was moved, etc.)?

Support phone numbers

For the most current HP list of telephone support numbers and call costs information, see www.hp.com/support.

After the phone support period

After the phone support period, help is available from HP at an additional cost. Help may also be available at the
HP online support Web site: www.hp.com/support. Contact your HP dealer or call the support phone number for
your country/region to learn more about support options.

Additional warranty options

Extended service plans are available for the HP Deskjet 2520 series at additional costs. Go to www.hp.com/
support, select your country/region and language, then explore the services and warranty area for information
about the extended service plans.
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9 Technical information

The technical specifications and international regulatory information for the HP Deskjet 2520 series are provided
in this section.

For additional specifications, see the printed documentation that came with the HP Deskjet 2520 series.
This section contains the following topics:

. Notice

. Specifications

. Environmental product stewardship program
. Regulatory notices

Notice

Hewlett-Packard Company notices

The information contained in this document is subject to change without notice,

Al rights reserved. Reproduction, adoplation, o translation of this material is prohibited withoul prior written permission
of Hewdett-Pockard, except as allowed under copyright lovws. The only warranties for HP products and services are sat forth
in the express waranty statements accompanying such products and services. Mothing herein should be construed os
conslituting an edditional warranty. HP shall not be liable for technical or editorial errors or omissions contained hersin,
© 2012 Hewlett-Pockord Development Company, LF.

Microsoft, Windows, Windows XF, and Windows Vista are U.5. regigtered trodemarks of Microsoft Corporation.
Windows 7 is either o registered trodemark or trodemark of Micresolt Corporation in the United Siales and/or other
countries,

Intel and Pentium are trodemarks or registered trodemarks of Intel Corporation or its subsidiaries in the United States and
cither couniries,

Adobe® iz a trademark of Adobe Systems Incorporated.

Specifications

Technical specifications for the HP Deskjet 2520 series are provided in this section. For more technical
specifications, see the Product Data Sheet at www.hp.com/support.

This section contains the following topics:

. Paper weights
. Print specifications

. Copy specifications
. Scan specifications
. Print resolution

. Power specifications

. Cartridge yield
. Acoustic information

. System requirements g
. Environmental specifications ‘é
. Input tray capacity o
K}
. Output tray capacity E
- Papersize 8
£
(5]
(4}
|—

System requirements

For information about future operating system releases and support, visit the HP online support Web site at
www.hp.com/support.
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Environmental specifications

Recommended operating temperature range: 15 °C to 32 °C (59 °F to 90 °F)

Allowable operating temperature range: 5 °C to 40 °C (41 °F to 104 °F)

Humidity: 15% to 80% RH non-condensing; 28 °C maximum dewpoint

Non-operating (Storage) temperature range: —40 °C to 60 °C (40 °F to 140 °F)

In the presence of high electromagnetic fields, it is possible the output from the HP Deskjet 2520 series may
be slightly distorted

HP recommends using a USB cable less than or equal to 3 m (10 feet) in length to minimize injected noise
due to potential high electromagnetic fields

Input tray capacity
Plain paper sheets (80 g/m? [20Ib]): Up to 50

Envelopes: Up to 5

Index cards: Up to 20

Photo paper sheets: Up to 20

Output tray capacity
Plain paper sheets (80 g/m? [20Ib]): Up to 30

Envelopes: Up to 5

Index cards: Up to 10

Photo paper sheets: Up to 10

Paper size

For a complete list of supported media sizes, see the printer software.

Paper weights
Plain Paper: 64 to 90 g/m? (16 to 24 Ib)
Envelopes: 75 to 90 g/m? (20 to 24 Ib)

Cards: Up to 200 g/m? (110-Ib index maximum)
Photo Paper: Up to 280 g/m? (75 Ib)

Print specifications

Print speeds vary according to the complexity of the document
Method: drop-on-demand thermal inkjet
Language: PCL3 GUI

Copy specifications

Digital image processing
Copy speeds vary according to the complexity of the document and model

Scan specifications

Resolution: up to 1200 x 1200 ppi optical

For more information about ppi resolution, see the scanner software.
Color: 24-bit color, 8-bit grayscale (256 levels of gray)

Maximum scan size from glass: 21.6 x 29.7 cm (8.5 x 11.7 inches)

Print resolution

Draft mode

Color Input/Black Render: 300x300dpi
Output (Black/Color): Automatic

Normal mode

Color Input/Black Render: 600x300dpi
Output (Black/Color): Automatic

Technical information



Plain-Best mode
. Color Input/Black Render: 600x600dpi

. Qutput: 600x1200dpi (Black), Automatic (Color)

Photo-Best mode
. Color Input/Black Render: 600x600dpi

. QOutput (Black/Color): Automatic

Max DPI mode
. Color Input/Black Render: 1200x1200dpi
. Output: Automatic (Black), 4800x1200 optimized dpi (Color)

Power specifications

0957-2286
. Input voltage: 100-240Vac (+/- 10%)
. Input frequency: 50/60 Hz (+/- 3Hz)

0957-2398
. Input voltage: 100-240Vac (+/- 10%)
. Input frequency: 50/60 Hz (+/- 3Hz)

0957-2290
. Input voltage: 200-240Vac (+/- 10%)
. Input frequency: 50/60 Hz (+/- 3Hz)

Br NOTE: Use only with the power adapter supplied by HP.

Cartridge yield

Visit www.hp.com/go/learnaboutsupplies for more information on estimated cartridge yields.

Acoustic information

If you have Internet access, you can get acoustic information from the HP Web site. Go to: www.hp.com/support.

Environmental product stewardship program

Hewlett-Packard is committed to providing quality products in an environmentally sound manner. Design for
recycling has been incorporated into this product. The number of materials has been kept to a minimum while
ensuring proper functionality and reliability. Dissimilar materials have been designed to separate easily.
Fasteners and other connections are easy to locate, access, and remove using common tools. High priority parts

have been designed to access quickly for efficient disassembly and repair. _5
For more information, visit HP’s Commitment to the Environment Web site at: g
(]
www.hp.com/hpinfo/globalcitizenship/environment/index.html. £
This section contains the following topics: g
L=
. Eco-Tips E
. Paper use
. Plastics

. Material safety data sheets

. Recycling program

. HP inkjet supplies recycling program

. Power consumption

. Auto Power-Off

. Sleep mode

. Disposal of waste equipment by users in private households in the European Union
. Chemical Substances
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. Toxic and hazardous substance table (China)
. Restriction of hazardous substance (Ukraine)

Eco-Tips

HP is committed to helping customers reduce their environmental footprint. HP has provided the Eco-Tips below
to help you focus on ways to assess and reduce the impact of your printing choices. In addition to specific
features in this product, please visit the HP Eco Solutions web site for more information on HP’s environmental
initiatives.

www.hp.com/hpinfo/globalcitizenship/environment/

Paper use
This product is suited for the use of recycled paper according to DIN 19309 and EN 12281:2002.

Plastics

Plastic parts over 25 grams are marked according to international standards that enhance the ability to identify
plastics for recycling purposes at the end of product life.

Material safety data sheets
Material safety data sheets (MSDS) can be obtained from the HP Web site at:

www.hp.com/go/msds

Recycling program

HP offers an increasing number of product return and recycling programs in many countries/regions, and partners
with some of the largest electronic recycling centers throughout the world. HP conserves resources by reselling
some of its most popular products. For more information regarding recycling of HP products, please visit:

www.hp.com/hpinfo/globalcitizenship/environment/recycle/

HP inkjet supplies recycling program

HP is committed to protecting the environment. The HP Inkjet Supplies Recycling Program is available in many
countries/regions, and lets you recycle used print cartridges and ink cartridges free of charge. For more
information, go to the following Web site:

www.hp.com/hpinfo/globalcitizenship/environment/recycle/

Power consumption

Hewlett-Packard printing and imaging equipment marked with the ENERGY STAR® logo is qualified to the U.S.
Environmental Protection Agency’s ENERGY STAR specifications for imaging equipment. The following mark will
appear on ENERGY STAR qualified imaging products:

-
(]
(2]
=2
=
o
=
=
=
(=]
=]
3
D
=
(=]
=1

Additional ENERGY STAR qualified imaging product model information is listed at: www.hp.com/go/energystar

Auto Power-Off

Auto Power-Off is automatically enabled by default when you turn on the printer. When Auto Power-Off is
enabled, the printer will automatically turn off after two hours of inactivity to help reduce energy use. You can
change the Auto Power-Off setting from the printer software. Once you change the setting, the printer will
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maintain the setting that you choose. Auto Power-Off turns the printer off completely, so you must use the
power button to turn the printer back on.

To enable or disable Auto Power-Off
1. Click the HP Deskjet 2520 series desktop icon to open the Printer Software.

Bf NOTE: You can also access the Printer Software by clicking Start > Programs > HP > HP Deskjet
2520 series > HP Deskjet 2520 series

2. Inthe Printer Software, click Print & Scan and then click Maintain Your Printer to access the HP Deskjet
2520 series Toolbox.

3.  The HP Deskjet 2520 series Toolbox appears.
4. Click Advanced Settings. Follow the onscreen instructions.

O TIP: If you are printing through a wireless or Ethernet connection over a network, Auto Power-Off should be
disabled to ensure that print jobs do not get lost. Even when Auto Power-Off is disabled, the printer enters a
Sleep mode after five minutes of inactivity to help reduce energy use.

Sleep mode
. Power usage is reduced while in Sleep mode.
. After initial setup of printer, the printer will enter Sleep mode after five minutes of inactivity.
. The time to Sleep mode cannot be changed.
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Blsposal of waste equipment by users in private households in the European
nion

Dipassl ol Wosirs Cyuprrast by Usirs la Frizass Hosssh lids

Berrmbd vt b= oty ot [} puter e g s e PR ST ET I [SPU I PR ¥ PA S J———
s by | g i 3 e collicbon gl for P recy g o wasis secics and slecien s The soperate coflecion ond reydng o ovt e sqeipmest

;-ﬂ ey o e el i vl e tnd = urraran fad madel bman kB s D e rere | e e phem aan
o e g .u-...“.-.- ot raryri vy plance rremet s bl oty rliee vt heinabokl cote dhueed s s o {hop s o paerrad b poest
[ TS B ) e N e TR = ST —
Lepimcads m oollle T w-l:.la.uwhlm ks e v B ey e v b fa o guoded dul b b s s dichats comanis

e & ok At i e vt £ ot i i o e g b
lagn i i she oy dopaprmanh npagie b it . —

e oo o Febore b e o i ' o e s v, oom s e e
e, g s b s v erd kel e el

e e il cmprd o sk} byl fabe e Vergnimeteny,
m|. L :\.e..mm:a.-.-;.ui.\.dm
I....l ....-u. ..u dast il e e i s
ey

e — kg e L e, e ki o
m—i—-ﬂ-—-odﬁn da serrorvare de rulumnnpu
cx-;...a,.n.a.......-..l..........l.u.l..........u.! o e ks i i A ek i 5 s il e
Jomr-immprar St e g o i i L [ .y oy i Vg e i v gy g S

pred il ceesuecha i o o oo sy brseime s e
a5 s kit ddie k. P i e sl e
s g e ot i

iom dekd s vateol & garmricoes o ol ook arguss s
s s 1 o e i

rinfenkcoieirl

= i i prweees d yembe &

[ —— o bt SR o b ks B

koo ] ki mhm:umi.omu.oamﬁuummimau. s iz ot oo 1 ok b sl g e rsh,
el e e kg i it e P o oy ekt et e ==
o ey - il .,..o-._.r-:-h.-m-l._na..l..b..a.-- g g et b

s o ks e st sl B o e, e paen i com ke, om bk s oo 1 o, ] bbb ik o A ik Aot = oo 12

[P gt . ey

L kb v S D i gl 4 hassisinint 0 Bastish £

ks rmrln it prask s nsbern e shok trsarap e e T g sy o etk s
b,.a.mli sl v s

o b, ol

'ﬂuh‘l Ilbmrh'h
s e

e

e bbabdmnpatiad
il b el nFmasadir e tepeeal rebamieg aq gackre
i o 8 B, ot b e e ks s s
e nmien the s by b e el el d

-
s e b e 1
o b e vy g i it o e ot b e

. e e
et iy e T e e

]
5
3

" i id - sdan
Vi ] A e gl e Ly 1 A o s e e e o b 5 s s s sl st bl o alabacsbsssaesis
e Bmremedbin, [levrmitecale mmdeapin sk Loprm s o Ll s sy bl e o oyt . Lo e vt b f e, b e bl
Lisodsgrnisshle botio, by il s iumseiors oot s b ek 10, moke bisda ohaan aeeovl S, olesjiniie ol s Bamsers spenk ol 5 Losghessd, Lasi o madess s

watsrhy oheoadla
T i i ks s i i, 8 b s iy ki, e, i i bl e b 3, 584 bt e

oy gy aplage . Y et ity abroeuely yeub e Sy ey s iy v i H—_—
gttty s ks b e i, e 8 it el s o oo Laniyopodaais sl eromsid, Blhiali m ot
i ot

Mzrﬂm- wangaiin ooy bopardieg Truag
Tn - el i o prm e s R e e i e b mpen n e el el e g S ey m mn
SmEpipeE 1% dgpnay cemai of sty B i L 2 g g |¢'n-! cna.-mc.g:m quﬁ:}- "2 ?Idpa—-hml-o.o. H.,a vy Lioen <t

3 e b |
o bmare.s e e deneed
ol ...tmnhoq-:m:m At

o e e e e e

ko i i,

e am e
e i, b g e e il s P

b g e, lediw, ol a0 -wwm-aub.. fmnmtudnhn u :-unul 3 :. nl-:l. um -m-dmu.o-q.m

Turapes Sqjen nmu -bd--nrm'-l-mmn

R e e e - idmein, imrl 1a i v o it g b 4w s ki e ek
derlomer sl e 4 ek e vy e bt s wrdear ot paicbmm e or rafamiat o kb . i e, Lo e

,n.r.m e kAW GO e b D ko i o At e paecrb oh G Aon Y boipld | BULEEY S lory . rg e
i i e § bl s Lot ot ity

ol e mellysags s pruss wipskoviloiu i = hal Dsrapfabitsd

bl Sy .......r.u....a..... o, g ....|..|......1. O vu o ¢ by mlip s dhomese wheam sy i Ly el gl wdipercasndly ey 1o

chociecopace s age spraws de s ¢ e i g adona . ks by g | Mot e math, Exareacneis sk e socrling e T

oy 7 ey ke b g o e il by, Dk el et ke s iy i e

Fiviins = mdpmospin wh b i abayh, = provis ot et oem refem ey 8 morecmbe. b b = m g T i

Cumimete s opsiprrsanien per assrien s reddi i e Un s Farassin

Erin thnbolo w0 prows.oa 03 susalages. o 4.0 o puock o e pode o dmscarmds v oo o oo domiien. |l anioeic, 8 o

o diiacinb, & v il o e . ol g ks = s i i
sravie e e ermmrce pie.

i locur o scppemari
b

pomin e g s gt B o i oy e
b aan b s hudcoran aparein b pasa kg, ek B coake o o smrbiets val e e i, @ e 8 g okl i s b

kit 4 pr
Pasnsg |mw-hrum.lm i gt s serladinia v dessiiars pasdicuns 85 slvad
o _I.'i' i o o g el g vl " [T S U BT VOIS R —
¥ e shlyoucd i rraduel Sepmeen bt “vardk
s Foskls Frlic iafrs e & iy sl

v b e picd
o by s v .......l_.. po vy ......|..| [F)

To el 2 u!ll-.-ﬂu #MN:;LMQIMH- x Mﬁ

el bl i
e v e g -
& bom ke pod i ob igovird, b 1 skl b

[
s o \J 2 dregim. gupode il = i adoad |
i b e s s .....’f’:...‘“.“.....ﬂ. e

cleeepe e s shaipe N rdorma ) s Peseih, L Inbln et v e npreems 4

opee ¢ e dal ivi addal o doboiera e
ke .Jn-ir-\n-"r-uwh-u.
. lnben il e

1er haes- ach

m..n.-ﬂ. [isier' sy .1......-....1..|.- e S i g bl el e s e s ot e s bl e s
o rub gLk ke Copemre i s Lomsmmmbeprrad i 1 frveruray e 57 Ml bt bavnen s e mrmmens pularmm e o [y

ke ao?ﬂua ph ma.m el g i i Fommmsoka e ghainr, sophavasie g bssiog o be B i vore | 2ot Loe s et inform o o ver de boeat
Linsorale [

Chemical Substances

HP is committed to providing our customers with information about the chemical substances in our products as
needed to comply with legal requirements such as REACH (Regulation EC No 1907/2006 of the European
Parliament and the Council). A chemical information report for this product can be found at: www.hp.com/go/
reach.
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Toxic and hazardous substance table (China)
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Restriction of hazardous substance (Ukraine)
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HebOesneuHux peqosmH (Ykpaina)
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Regulatory notices

The HP Deskjet 2520 series meets product requirements from regulatory agencies in your country/region.
This section contains the following topics:

Regulatory model identification number

ECC statement

Notice to users in Korea

VCCI (Class B) compliance statement for users in Japan
Notice to users in Japan about the power cord
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Regulatory model identification number

For regulatory identification purposes, your product is assigned a Regulatory Model Number. The Regulatory
Model Number for your product is VCVRA-1221. This regulatory number should not be confused with the
marketing name (HP Deskjet Ink Advantage 2520hc All-In-One series, etc.) or product numbers (CX027A,
CX027B, etc.).
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FCC statement
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FCC statement

The United States Federal Communications Commission (in 47 CFR 15.105) has specified
that the following notice be brought to the attention of users of this product.

This equipment has been tested and found to comply with the limits for a Class B digital
device, pursuant fo Part 15 of the FCC Rules. These limits are designed to provide reason-
able profection against harmful interference in a residential installation. This equipment
generates, uses and can radiate radio frequency energy and, if not installed and used in
accordance with the instructions, may cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation.
I this equipment does cause harmful interference to radio or television reception, which can
be determined by turning the equipment off and on, the user is encouraged to try to correct
the interference by one or more of the following measures:

Reorient the receiving antenna.
Increase the separation between the equipment and the receiver.

Connect the equipment info an outlet on a circuit different from that to which the
receiver is connected.

Consult the dealer or an experienced radio/TV technician for help.

For further information, contact:
Manager of Corporate Product Regulations
Hewlett-Packard Company
3000 Hanover Street
Palo Alto, Ca 94304
(650) 8571501

Medifications (part 15.21)

The FCC requires the user to be notified that any changes or modifications made to this
device that are not expressly approved by HP may void the user's authority to operate the
equipment.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following
two conditions: (1) this device may not cause harmful inferference, and (2) this device must
accept any interference received, including inferference that may cause undesired
operation.

Notice to users in Korea
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VCCI (Class B) compliance statement for users in Japan
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VCCI-B

Notice to users in Japan about the power cord
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